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1. WYMOGI BEZPIECZEŃSTWA 

 
 

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 

urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości! 

 

UWAGA: Wszelkich podłączeń i zmian należy dokonywać przy odłączonym napięciu 

zasilającym. 

 

UWAGA:  Instalacja oraz programowanie urządzenia wymagają posiadania odpowiednich 

umiejętności, dlatego mogą być dokonywane tylko przez wykwalifikowany 

personel po zapoznaniu się w całości z instrukcją obsługi. 

 

UWAGA:  W przypadku, gdy urządzenie ulegnie uszkodzeniu, należy skontaktować się ze 

sprzedawcą lub osobą odpowiedzialną za instalację.  
 

UWAGA:  Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu. 

 

UWAGA:  Odpowiedzialność za prawidłową instalację urządzenia spoczywa na osobie 

montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy 

obowiązujące w danym kraju.  

 

UWAGA: Wyładowania elektrostatyczne mogą uszkodzić urządzenie. Należy stosować 
odpowiednie zabezpieczenie. 

 

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują 
utratę gwarancji.  
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2. Wstęp 
 

Moduł MCTH-1 służy do pomiaru temperatury w zakresie -40ºC do +85ºC, a wilgotności 

w zakresie 0-100%RH. Dokładność pomiaru temperatury wynosi max.  ±0.5ºC, a wilgotności ±3%. 

W trybie stałoprzecinkowym rozdzielczość pomiaru temperatury i wilgotności wynosi odpowiednio 

0.1ºC i 0.1%. Moduł może być zasilany napięciem od 9 do 24V prądu stałego (DC). Maksymalny 

pobór prądu wynosi 100mA przy napięciu zasilania 24VDC i zależy od długości magistrali RS485, 

ilości świecących diod LED, temperatury otoczenia oraz napięcia zasilania modułu. Wymiary 

modułu pozwalają na zmieszczenie go w standardowej puszce instalacyjnej.  

 

 
Rys. 1. Widok modułu MCTH-1 

 

 

 

3. Dane techniczne 
 

Tabela 1. Parametry graniczne 

Nazwa parametru Uwagi Min. Max. 

Napięcie zasilania 

24VDC 
Notka 1  35VDC 

Temperatura Notka 1 -20ºC 90ºC 

Napięcie na 

wyprowadzeniach 

SDA, SCL 

 -0.7VDC 6VDC 

 

 

Uwaga: Przekroczenie parametrów granicznych może spowodować uszkodzenie urządzenia, 

lub/i trwałe obniżenie parametrów. Długotrwała praca w warunkach bliskich parametrom 

granicznym może spowodować nieprawidłowe działanie układu, a nawet uszkodzenie 
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urządzenia. 
 

 

 

Tabela 2. Rekomendowane warunki pracy 

 

Nazwa parametru Uwagi Min. Typ. Max. 

Napięcie zasilania 

24VDC 
 9VDC 24V 32VDC 

Prąd zasilania 24VDC   50mA 100mA 

Napięcie na 

wyprowadzeniach 

SDA, SCL 

 0VDC  5.1VDC 

Temperatura pracy  -40ºC  80ºC 

Wilgotność Notka 1 5%  95% 

Wysokość  0m n.p.m.  2000m n.p.m. 

Notka 1: Wilgotność bez kondensacji! 

 

4. Instalacja 
4.1 Obwód elektryczny 

 

 
        Rys. 2. Rozmieszczenie elementów na płytce modułu 

U2 – CPU 

D1..D3 – diody LED sygnalizujące stan urządzenia 

SW1 – przełącznik konfigurujący prędkość komunikacji, adres płytki oraz 

tryb Modbus 
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Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 

uszkodzenie urządzenia nie objęte gwarancją! 
 

         

        Tabela 3. Złącze J2: 

Numer pinu Nazwa Opis 

1 +V Plus zasilania 

2 GND Minus zasilania 

3 D- Interfejs RS-485 

4 D+ Interfejs RS-485 

5 Vcc Plus zasilania czujników 

6 SDA Linia danych czujnika 

7 SCL Linia zegara czujnika 

8 GND Minus zasilania czujników 

 

 

  

Tabela 4. Diody sygnalizacyjne: 

Nr diody Kolor Nazwa Opis 

D1 zielony RX Sygnalizuje odbieranie, jeśli miga 

D2 czerwony TX Sygnalizuje nadawanie, jeśli miga 

D3 czerwony CPU 

Zmiana stanu diody (świeci → nie 

świeci, nie świeci → świeci) sygnalizuje 

wykonanie pomiaru i poprawną pracę 

CPU 

Uwaga: Na module zamiast diod czerwonych mogą być zamontowane diody 

pomarańczowe 

 

 

Nieprzerwane świecenie się diod RX i TX sygnalizuje możliwość błędu w podłączeniu sygnałów 

do gniazda. Miganie tylko diody sygnalizującej odbieranie danych przez moduł sygnalizuje 

możliwość wysyłania błędnego adresu, lub wybranie błędnych parametrów transmisji 

(nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.) 

 

 

 

4.2  Przykład podłączenia elektrycznego 
 
 
Poniższy rysunek przedstawia schemat typowego podłączenia układu do  magistrali RS-485. Moduł 

pomiaru wilgotności i temperatury można zasilać napięciem stałym z zakresu 9...24V. Do 

urządzenia można podłączyć jeden zintegrowany czujnik temperatury i wilgotności. 

 

Komunikacja modułu z innymi urządzeniami realizowana jest z wykorzystaniem protokołu Modbus 

po magistrali RS-485. Przewody należy podłączyć według rysunku (rys. 2). Moduł może pracować 

tylko jako urządzenie slave. Adres fizyczny urządzenia w protokole Modbus, prędkość komunikacji 

i tryb Modbus (RTU/ASCII) ustala się przełącznikiem SW1, co zostanie opisane w dalszej części 
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instrukcji.  

 

Długość przewodów łączących płytkę modułu z czujnikiem może wynosić maksymalnie 10cm! 

 
Rys. 3 Przykład połączenia modułu MCTH-1 
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4.3  Ustawianie prędkości, adresu i trybu Modbus  
 

 
 

Rys. 4 Switch SW1 do ustawiania adresu Modbus (zworki 1-6).  

Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu. 

 

W położeniu przedstawionym na widoku płytki, zworka w pozycji OFF oznacza 1, zworka 

w pozycji ON – 0.  

 

W switchu SW1 zworki 1..6 służą do ustawienia adresu w protokole Modbus (A0..A5) modułu 

wilgotności: 

1 – A0 (najmniej znaczący bit adresu - LSB) 

2 – A1 

3 – A2 

4 – A3 

5 – A4 

6 – A5 (najbardziej znaczący bit adresu - MSB) 

 

Adres modułu wilgotności w protokole Modbus: 

- ustala się sprzętowo za pomocą switcha SW1,  

- może przyjmować wartości 1..63,  

- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast),  

- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu 

ustawiony jako 0. Switch w pozycji OFF to bit adresu ustawiony jako 1.  
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5.3.2. Ustawianie trybu Modbusa za pomocą switcha SW1 

 
Zworka 7 (z zestawu SW1) służy do ustawiania trybu Modbusa. 

0 (pozycja ON) – Modbus RTU 

1 (pozycja OFF) – Modbus ASCII  

 

5.3.3. Ustawianie prędkości transmisji za pomocą switcha SW1 
 

Zworka 8 (z zestawu SW1) służy do ustawiania prędkości transmisji: 

0 (pozycja ON) – prędkość 9600 baud  

1 (pozycja OFF) – prędkość 57600 baud 

 

Uwaga: W module i urządzeniu nim sterującym muszą być ustawione takie same parametry 

transmisji! 
 

Uwaga: Aby zmienić adres płytki lub prędkość komunikacji, należy ustawić żądany adres 

i prędkość, a następnie wyłączyć i włączyć zasilanie. Zmiana adresu przy włączonym zasilaniu 

nie odniesie skutku aż do następnego wyłączenia i włączenia zasilania. Ustawienie adresu 

płytki na 0 spowoduje nieprawidłową pracę modułu. 
 

5. Konfiguracja 

 

5.1. Parametry transmisji danych 
 

Moduł komunikuje się z urządzeniem sterującym za pomocą protokołu Modbus RTU/ASCII. 

W warstwie fizycznej połączenie jest realizowane za pomocą interfejsu RS-485 2W, half-duplex 

(z przełączaniem kierunku transmisji).  

 

      Tabela 5. Parametry transmisji w trybie RTU: 

prędkość: 9600/57600 baud (przełączane zworką) 

parzystość: Even 

ilość bitów danych: 8 

ilość bitów stopu: 1 

 

      Tabela 6. Parametry transmisji w trybie ASCII: 

prędkość: 9600/57600 baud (przełączane zworką) 

parzystość: Even 

ilość bitów danych: 7 

ilość bitów stopu: 1 

 

      Tabela 7. Rejestry Modbus i ich znaczenie w module temperatury i wilgotności: 

Numer rejestru Nazwa Opis 

1100 Autokonfiguracja (111) Rejestr do konfiguracji 

1101 Wersja firmware Numer wersji oprogramowania 

1200 Odczyt temperatury z czujnika Wartość temperatury odczytana 

bezpośrednio z czujnika 
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1201 Odczyt wilgotności z czujnika Wartość wilgotności odczytana 

bezpośrednio z czujnika (bez 

kompensacji) 

1202 Error Pojawienie się wartości innej 

niż zero sygnalizuje błąd 

1203 Czas pomiędzy odczytami Ustawiany, domyślnie 1s 

1204 Temperatura skompensowana Float, starsze 16 bitów 

1205 Temperatura skompensowana Float, młodsze 16 bitów 

1206 Wilgotność skompensowana Float, starsze 16 bitów 

1207 Wilgotność skompensowana Float, młodsze 16 bitów 

1208 Temperatura znak Znak temperatury 0: +, 1: –   

1209 Temperatura całkowita Część całkowita temperatury 

1210 Temperatura reszta Część ułamkowa temperatury 

1211 Wilgotność całkowita Część całkowita wilgotności 

1212 Wilgotność reszta Część ułamkowa wilgotności 

 

Przykład: 
Adres 1100: 111 

Adres 1101: 210 

Adres 1200: 6439 

Adres 1201: 2080 

Adres 1202: 0 

Adres 1203: 2 

Adres 1204: 7864 

Adres 1205: 16835 

Adres 1206: 16525 

Adres 1207: 17032 

Adres 1208: 1 

Adres 1209: 25 

Adres 1210: 6 

Adres 1211: 73 

Adres 1212: 4 

 

      Tabela 8. Interpretacja przykładowych wartości znajdujących się  
          w rejestrach Modbus w module temperatury i wilgotności 

 
Autokonfiguracja 111 oznacza moduł pomiaru 

wilgotności i temperatury 

Wersja firmware 210 oznacza wersję 2.1.0 

Odczyt temperatury z czujnika: 6439 jednostek własnych 

Odczyt wilgotności z czujnika: 2080 jednostek własnych, brak błędów 

Pomiar temperatury: co 2s 

Skompensowana wartość temperatury 

w postaci zmiennoprzecinkowej:  

starsze 16 bitów: 7864,  

młodsze 16 bitów: 16835 

Skompensowana wartość wilgotności 

w postaci zmiennoprzecinkowej: 

starsze 16 bitów: 16525,  

młodsze 16 bitów: 17032 

Adresy 1208..1210: temperatura -25.6 st.C 

Adresy 1211..1212: wilgotność 73.4% 

 

Aby zobaczyć temperaturę i wilgotność w czytelnym, znormalizowanym formacie, należy w tablicy 

„StatusPage” programu WinProLadder wypisać w postaci „Floating” wartości podwójnych 

rejestrów DR odpowiadających skompensowanej temperaturze i wilgotności. Dla powyższego 
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przykładu będzie to wyglądać następująco: 

 

 

 
 Ref. No. Status Data 

Odczyt temperatury: DR1204 Floating 24,3899 

Odczyt wilgotności: DR1206 Floating 68,12607 

 
 

 

5.2. Przykład podłączenia modułu do sterownika PLC Fatek 

 
Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port 

w sterowniku PLC. Możemy tego dokonać za pomocą programu  WinProLadder. Wybieramy 

z menu PLC → Setting → Port (numer portu, po którym będzie odbywała się komunikacja):  

 

 
Rys.5 Wybór portu komunikacyjnego w sterowniku PLC 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji 

w trybie RTU: 

 

Prędkość (Baud Rate):    9600/57600 (ustawiane zworką)  

Parzystość (Parity)    even 

Ilość bitów danych (Data Bit):   8 

Ilość bitów stopu: (Stop Bit)   1 

Protokół      Modbus RTU (slave) 
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Rys. 6 Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji 

w trybie ASCII: 

 

Prędkość (Baud Rate):    9600/57600 (ustawiane zworką)  

Parzystość (Parity)    even 

Ilość bitów danych (Data Bit):   7 

Ilość bitów stopu: (Stop Bit)   1 

Protokół      Modbus ASCII (slave) 

 

 
Rys. 7 Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII 
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Sterownik ustawiony jako „master” musi mieć uruchomioną funkcję M_BUS (funkcja 150). 

W funkcji M_BUS (150) użytkownik ustawia tylko port, którego będzie używał do komunikacji, 

rejestr startowy programu do komunikacji oraz rejestr roboczy.  

 

Funkcja 150.M_BUS 

 
Rys. 8 Symbol funkcji 150.M_BUS 

 

Pt: Numer portu, który ma być użyty do komunikacji 

SR: Rejestr startowy  

WR: Rejestr roboczy  

Jeżeli wejście A/R = 0   - protokół Modbus 

Jeżeli wejście A/R = 1   - protokół Modbus ASCII 

Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie 

zaczyna się od pierwszego pakietu danych. 

 

Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  tworzymy tabelę. 

Z menu wybieramy Project → Modbus Master Table → Add Modbus Master Table. 

 

 

 
 

Rys. 9. Widok ekranu przy wstawianiu z menu tabeli do obsługi Modbusa w programie 

WinProladder. 
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Rys. 10. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli do obsługi Modbusa  

w programie WinProladder. 

 

 

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit.  

 

 

 
Rys. 11. Okno konfiguracji funkcji Modbus w sterowniku FATEK. 

 

W polu Table Name użytkownik może wpisać dowolną nazwę np. modbus, natomiast 

w polu Table Starting Address należy wpisać rejestr startowy, który został użyty w programie 

w funkcji 150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można 

dodawać komendy.  
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Rys. 12. Okno edycji komend w komunikacji Modbus. 

 

 

Po naciśnięciu przycisku Add pojawia się okienko Command Item, w którym należy wprowadzić 

numer stacji Slave Station (adres modułu), następnie wybrać rodzaj komendy (read/write), rozmiar 

przesyłanych danych, adres startowy w sterowniku „master” oraz adres startowy w module. 

 

Przykładowa konfiguracja (odczyt temperatury): 

Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read (Odczyt) 

Data Size:   2 (starsze i młodsze słowo temperatury) 

Master Data Start Address: np.: R400 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401204 (początkowy rejestr odczytywany z modułu) 

 

Przykładowa konfiguracja (odczyt wilgotności): 

Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read (Odczyt) 

Data Size:   2 (starsze i młodsze słowo wilgotności skompensowanej) 

Master Data Start Address: np.: R402 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401206 (początkowy rejestr odczytywany z modułu) 

 

Przykładowa konfiguracja (zmiana czasu odczytu): 

Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Write (Zapis) 

Data Size:   1  

Master Data Start Address: np.: R412 (zapisuje do modułu wartość z tego rejestru) 

Slave Data Start Address: np.: 401203 (docelowy adres w module) 

 

Przykładowa konfiguracja (odczyt błędu): 

Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read (Odczyt) 

Data Size:   1  

Master Data Start Address: np.: R413 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401202 
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Przykładowa konfiguracja (odczyt temperatury i wilgotności): 

Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read 

Data Size:   5  

Master Data Start Address: np.: R415 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401208 (docelowy adres w module) 

 

5.3. Przykład podłączenia modułu do panelu HMI 

 
Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port 

w panelu HMI. Możemy tego dokonać za pomocą programu  EasyBuilder 8000. 

 

 

Wybieramy z menu Edit → System Parameters…. 

 

 

 
Rys.13 Okno do dodawania urządzeń podłączanych do panelu HMI 

 

Następnie klikamy na New…, w efekcie czego pojawi się okno jak na rysunku poniżej: 
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Rys.14 Okno do edycji parametrów komunikacji 

 

 

Możemy teraz ustawić parametry komunikacyjne urządzenia. Chcąc połączyć moduł z panelem po 

magistrali Modbus, należy w danych polach wybrać: 

 

PLC type - tryb komunikacji:  MODBUS RTU 

PLC I/F - typ portu, po którym będzie odbywać 

się komunikacja: 
RS-485 2W 

PLC default station no.: 
adres sprzętowy modułu  

pomiaru wilgotności i temperatury 

COM: 
numer i ustawienia portu, przez który odbywa 

się komunikacja panelu HMI z modułem. 

 

Aby ustawić te parametry, należy kliknąć na pole Settings… i wybrać odpowiednie wartości: 

 

• COM (numer portu komunikacyjnego):  COM 1 

• Baud rate (prędkość komunikacji):   57600  

• Data bits (ilość bitów danych)   8 

• Parity (parzystość):    Even 

• Stop bits (ilość bitów stopu):    1 

 

 

 
Rys. 15 Ustawienia portu komunikacyjnego 
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Przykładowa konfiguracja: 

 
− Odczyt temperatury (lub wilgotności): 

 

Aby odczytywać żądaną wartość z modułu, należy utworzyć odpowiedni obiekt w panelu HMI 

wyświetlający tę wartość.  

 

W tym celu wybieramy: menu Objects → Numeric/ASCII → Numeric Display 

 

 
Rys. 16 Tworzenie obiektu Numeric Display 

 

Pojawi się okno Numeric Display Object’s Properties, w którym w celu odczytu temperatury 

należy: 

 

W zakładce „General” wybrać: 

• Description        (własny opis obiektu) 

• PLC name:        MODBUS RTU 

• Device type:        4x 

• Address (numer rejestru, który chcemy odczytać- patrz strona 7): 1204 

(1204 dla temperatury,  1206 dla wilgotności) 
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Rys. 17 Właściwości obiektu Numeric Display 

 

W zakładce „Numeric Format” należy wybrać: 

• Data Format:  32-bit Float 

• Mask:   Odznaczyć 

• Left of decimal Pt: 3  (część całkowita) 

• Right of decimal Pt: 4  (część ułamkowa) 

 
 

 

 

 

Rys. 18 Właściwości obiektu Numeric Display 
 

 

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej 

programu EasyBuilder. Po załadowaniu programu do panelu HMI można już odczytywać 

temperaturę.  

 

 

W celu zmiany wielkości okresu próbkowania należy wykonać tę samą procedurę co powyżej, z tą 

różnicą, że nie wybieramy już obiektu wyświetlającego dane, tylko obiekt odpowiedzialny za 

wpisywanie danych, czyli „Numeric Input”. W skrócie: 
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W zakładce „General” wybrać: 

 

• Description         (własny opis obiektu) 

• PLC name:        MODBUS RTU 

• Device type:        4x 

• Address (numer rejestru przechowujący czas między odczytem): 1203 

 

 

 
Rys. 19 Właściwości obiektu Numeric Display 

 

 

W zakładce„Numeric Format” należy wybrać: 

 

• Data Format:  16-bit Unsigned 

• Mask:   Odznaczyć 

• Left of decimal Pt: 3  

• Right of decimal Pt: 0  

 



 

 21 

 
Rys.20 Właściwości obiektu Numeric Display 

 

 

 

5.4. Wymiary modułu pomiaru temperatury i wilgotności oraz wymiary 

czujnika temperatury i wilgotności 
 
Płytka drukowana ma wymiary: 37x36mm, wysokość maksymalna: 17mm. 

 

 
Rys. 21. Wymiary płytki drukowanej 
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Rys. 22 Wymiary czujnika MCTH-2 

 

 

 

 

6. Uwagi końcowe 
 

1. Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń. 

2. Produkt może nieznacznie różnić się od fotografii. 

3. Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, 

które mogą z nich wyniknąć. Jednocześnie producent oświadcza, że dołoży wszelkich 

starań, by żadne błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje 

o wszelkich błędach zamieści na swojej stronie internetowej.  

4. Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia. 

5. Aktualna wersja instrukcji znajduje się na stronie www.esea.pl. 

6. Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji oraz pytania w sprawach 

technicznych nie wyjaśnionych wyżej proszę kierować na e-mail: info@esea.pl.  

 

 

 

 

 

 

 

 

 


